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The Configuration window is used to make various settings and operations of the DS-0321 FFT Analysis
Software. All the settings required for measurement and analysis are included in "Configuration".

The "Configuration" window can be opened from the menu bar or from the pop-up menu displayed by
right-clicking on the graph window.

This instruction manual describes basic operations of Configuration taking Input/Output Setting for example.

Pay attention to marks ['¥ ] or buttons displayed.

Operations allow you to double-click.

Functions of other setting items are not described in this manual. For details on the other functions, refer to
the separate simplified manual.

m Operation Flow

-1 Displaying the initial screen
-2 Displaying the Configuration Window
-3  Basic operation of Configuration setting

-4 Adjusting the Configuration Window Width and
restoring Configuration window

-5  Summary of [Configuration] window
basic operation
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m Operation Procedure
1. Displaying the initial screen

@ The following screen will be displayed when you open the DS-0321 at the first time.

@ When you click data part in the screen, it is enclosed with orange box lines to show that it is
active, called active screen. The settings in the "Configuration" window are reflected in the
active screen.

® \When you click in the graph, it is enclosed with orange box lines to show that it is active.

® The settings in the "Configuration" window are reflected in the active screen partition, except for the
measurement items related to all the channels, including the frequency and voltage ranges.

® No operations are permitted on some items unless the system is in the “STOP” state. For example, the
character string indicating the average number of process times grays out during averaging measurement,
meaning that the setting is unchangeable.
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2. Displaying the Configuration Window

@ Click "View" > "Configuration” from the Main menu to open the "Configuration" window.

@ "Configuration" window is displayed.
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<Remarks>
Open/Close ®) button | [ »] means there are more details about the item. Double-click to open, and double-click again to
close.
(V) button [V] means there are details about the items. Click the character item to open.
Click to execute the command.
Click to show the dialog box for detailed condition setting.
(&) / (&) Click to switch ON and OFF
(") : OFF state
B : ON state
( ] | — Click to switch ON and OFF
/™ : OFF state
— : ON state

Click to show one of the following dialog box.

- To open a folder : shows [Browse For Folder] dialog box.

- To open a file : shows [Open] dialog box

+ To input text : shows [Text Input] dialog box

+ To input numeric value : shows [Numeric Input ] dialog box.

3. Basic operation of Configuration setting

-1. Input setting

@O Double-click [» Input/Output Setting] in [Configuration] to open Configuration window. [»] means
there are more details about the item. To close the [Input/Output Setting] window, double-click

again.

Configuration

+ X

¥ File
¥ Meas Control
¥ _Fdit
L |
¥ Analysiz Setting
¥ Data Disp Setting
¥ Maode
¥ View
¥ Window
¥ Option
¥ Help

@ Double-click the [» Input/Output Setting] to open the underlying detailed item.

¥ Fil
¥ Mass Control
k Edit
System Setine
Crogs Combnaton Seting
¥ Freg Range Sett
¥ Sampling Condition Setting
¥ Faotation nput Seiting
[ Trigger Condition Satting
Unit/Cal Satting
Window Funcison Seting
F Time=axis Preprocessing Setting

[ Open |

5-
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@ Inthe window of detailed item, ¥ or A button allows to change the setting.
Current setting is displayed in the right column.

¥ File
¥ Meaz Cantrol
¥ Edit
7 Thput/Output Setting
System Setting [Opi]
Grozs Combination Setting
¥ Freq Ranee Setting 20kHz
v | Open |
futo Range YWhen Range Owver
Woltage Range Unit Wrms
¥ GHY
¥ CGHZ
b GH3
b GHA

¥ Sampling Condition Setting

¥ Rotation Ihput Setting

¥ Trigeer Gondition Setting Repeat
Unit/Cal Setting
Window Function Setting

b Time-axiz Preprocessing Setting

¥ fverazing Setting Power Sum

b Schedule Setting

¥ Sig Output Setting

¥ fnalysiz Setting

¥ Data Disp Setting

¥ Maode

¥ View

¥ Windaw

¥ Option

¥ Help

@ Click [» CH1] to open setting window.

¥ File

¥ Meas Control

¥ Edit

<7 Input/Dutput Setting
Syztem Setting

Crozs Combination Setting
¥ Freq Ranee Setting
= Input Setting
Auto Range When Range Over
Woltaze Banee Linit

.

Auto Ranee
Coupling
CCLD

Auto Zero

Analog Filter

b CGHZ2

¥ GH3

¥ CGH4
¥ Sampling Condition Setting
¥ Raotation Input Setting
¥ Trigeer Condition Setting

Unit/Cal Setting

Window Function Setting

¥ Time-axis Preprocessing Setting
¥ fveraging Setting

b Schedule Setting

¥ Sie Output Setting

@
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® Click [Coupling] allows to select input coupling [AC] or [DC]. When [CCLD] in the [Coupling] is ON,
only [AC] is selectable. (The input of [CCLD] should be [AC].)
Please note that it may have this kind of restriction on other setting.

¥ File
¥ Meas Contral
B Edit
5 TnputdOutput Setting
Sygtem Setting [ Open |
Cross Combination Setting
F Freq Range Setting 20kHz
57 Input Setting
Auto Range When Range Cwver [E]
oltage Ranee Unit Vrms
=7 GHA1
£utn Banes —
A v
CGLD
futo Zeia LA
Analog Filter ZFLAT)
F GHZ
¥ CGH3
L 1
¥ Sampling Condition Setting Ihternal
F Raotation hput Setting
B Trizzer Gondition Settine Repeat
Unit/Cal Setting
‘Window Function Setting
¥ Time-axis Preprocessing Setting
b fveraging Setting Power Sum
¥ Schedule Setting
F Sig Output Setting
F fAnalyzis Setting
¥ Data Disp Setting
¥ Mods
B View
B Window
F Option
¥ Help

® To enable [CCLD] input, click (&5 putton on the right column. (B8] putton is replaced
(&85 and DC24V/4mA is supplied to the CCLD applicable detector. (CCLD input is ON.) This
function is used for accelerometer that is applicable to CCLD. Click (&5 putton again to turn
OFF the [CCLD] input. The [CCLD] and [Auto zero] are ON in the following figure.

¥ File
¥ Meas Contral
¥ Edit
7 Tnput/Dutput Setting
System Setting
Grozz Gombination Setting
¥ Freq Range Setting
7 Input Setting
Auto Range When Range Over
‘oltage Range Unit

~ GH1
Auto Range
Coupling
Auta Zero
finalog Filter

¥ CH2

F CH3

b CH4

¥ Sampling Gondition Setting
¥ Rotation Iput Setting

¥ Trigzer Gondition Setting Repeat
Unit/Gal Setting
‘Window Function Setting
b Time-axiz Preprocessing Setting
¥ Averaging Setting Power Sum
¥ Schedule Setting
¥ Sig Output Setting



ONO fOKKI

@ To change setting on [CH1] to [CH4], click [Open] button in [Input Setting] window. [Input Condition
Setting] window is opened and the settings from [CH1] to [CH4] can be changed at once.

¥ File
¥ Meas Cantrol
¥ Edit
5 Input/Output Setting
System Setting [ Open ]
Gross Combination Setting
ko Erac E. i Ok " ) b?l
I = oen ] I Input Condition Setting £l
Auto Range When Range Over Ej
Auto Range | Woltage Range | Coupling | GGLD Auto Zera Analog Filter
Voltage Ranee Unit Wrms
< GHA O cH | TVrms ac v O Z(FLATY ¥
futo Ranee (=) 0 GH2 O 1Wrms ¥ ac v O ZFLATY &
Goupling AC O GHz O TWrms (v ac v O ZIFLAT) »
GeLD Y O GH4 O tms v ac v [ ZIFLAT) ¥
Auta Zera @
Analog Filter Z{FLAT)
b CH2 | fvims |Cjore| KRN
¥ CH3 [ 1vrms [E[ore R
¥ CH4 |___1vrms [Ellor RSN
¥ Sampling Condition Setting Internal
¥ Rotation Input Settine [ Auto Range When Range Over
¥ Trizger Condition Setting Repeat
Unit/Cal Setting 7
‘Window Function Setting
¥ Time-axiz Preprocessing Setting
¥ Averaging Setting Power Sum
b Schedule Setting
¥ Sig Output Setting

F Analysiz Setting
¥ Data Disp Setting
¥ Mode

b Wiew

¥ Window

¥ Option

¥ Help

-2. Setting frequency range

@ To set frequency range, click [Input/Output Setting]> [Freq Range Setting]. A right column shows the
frequency range currently set. Click the right button of the column to select frequency range from the
pull-down menu. [20 kHz] is selected in the following example.

Configuration

26

¥ File ¥ File
¥ Meas Control ¥ Meas Control
¥ Edit ¥ Edit
<7 Tnput/Output Setting = Input/Output Setting
System Setting Open System Setting Open
Crozs Gombination Setting [ Open_| vt e —e—
¥ 20kHz ~k [ ¥ | 20kHz v
¥ INpUT oeting =l 1 IS
¥ Sampling Condition Setting Internal ‘ B Sampling Condition Setting
P Fotation Input Setting P Rotation Input Setting
B Trigeer Condition Setting Fepeat b Trigeer Condition Setting
Unit/Cal Setting Unit/Gal Setting
Window Function Setting Window Function Setting
¥ Time-axis Preprocessing Setting ¥ Time—axis Preprocessing Setting
B Averaging Setting Power Sum ¥ Averaging Setting
b Schedule Setting b Schedule Setting
F Sig Output Setting B Sig Qutput Setting

¥ fnalysiz Setting

¥ Data Dizp Setting

¥ Mode

¥ iew

¥ Wfindow

¥ Option

¥ Help

¥ Analysiz Setting

¥ Data Dizp Setting

¥ Mode

F iew

¥ Window

¥ Option

¥ Help




-3. Setting the number of averaging times
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Double-click [Input/Output Setting]>[» Averaging Setting] to see detailed items. [Averaging Count]
shows the number of averaging time currently set.
To change the number of averaging time, click the right =) button of the column. Since [Numeric

Input ] dialog box opens, key in the numerical value to set.

Configuration
¥ File
¥ Meas Contral
¥ Edit
“ Input/Quiput Setting
System Setting Open
Grosz Combination Setting
¥ Freq Range Setting 20kHz
¥ Input Setting
F Sampling Condition Setting Internal
F Rotation Input Setting
b Trigeer Condition Setting Repeat
Unit/Cal Setting
Window Function Setting
¥ Time-axis Preprocessing Setting
7 fAveraging Setting Pamer Sut
Averaging Partway Value
Conditi L t3 -
[0 W | I
PrrErSE T u
Exponential Averaging Weight
Undo Averaging
Start Time Overlap 0% E
Sweep Synchronized with Sig Qu | (==
Sweep GH
F Schedule Setting
¥ Sig Ouiput Setting Open

-4. File Setting

Numeric Input

[0

B

[iw]

|| Back |[ ¢ |

ER|EN)

[an]

ER|EN)

[wfh]

)]

[ 0K ‘ [ Cancel

— 9

@ Click [Configuration] window > [ »File] >[ Project File] > [New Project] > Exec ], The window
currently displaying is closed, and a window opens as a new project (measurement condition: initial

setting).

Configuration

¥ Project Settine
¥ Meaz Data File
¥ Record File

Open Offline Analysiz Data
B Print

Exit

¥ Meas Gontrol

~“ File
|\l Projcct Fils —_—
[1 = |
TThen Frojeet CRen
Save Project

C¥Documents and Settings¥All Users¥D

k Edit

¥ Thput/Output Setting

F fnalysis Setting

¥ Data Disp Setting

¥ Maode

B View

B Window

¥ Option

¥ Help
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4. Adjusting the Configuration Window Width and restoring Configuration window

-1. Adjusting the Configuration Window Width

Place a mouse over the line to show column width adjustment mark. The column can be adjusted by
dragging the line so that you may like. A click of the top-right an Automatic display size adjustment

button] adjusts the left column automatically.

+ X

Woltage Range Unit
¥ GH1
¥ GH2
¥ GH3
¥ GH4
¥ Sampling Condition Setting
¥ Rotation Input Setting
¥ Trigeer Condition Setting
Unit/Cal Setting
Window Function Setting
¥ Time-axiz Preprocessing Setting
¥ fveraging Setting
b Schedule Setting
¥ Sig Output Setting
¥ Analysis Setting

¥ File
¥ Meaz Control
¥ Edit
= Iput/Output Setting
System Setting Open
Cross Gombination Setting
¥ Freq Ranee Setting 20k Hz
> | Open |
Auto Range When Range Cwver E]

W

Tms

Internal

Fepeat

Fower Sum

¥ Data Disp Setting

¥ Mads

¥ View

¥ Window

¥ Option

¥ Help

-2. Restoring

Clicking the "Store" button (

¥ File

¥ Meaz Control

¥ Edit

57 Input/Cutput Setting

System Jetting [ Cpen |
Croge Combination Setting
F Freq Range Setting 20kHz
L o Open |
U Auto Ranee When Range Over | (==
“oltage Range Unit Wrms

¥ CH1
b CH2
F CH3
b CH4
¥ Sampling Condition Setting
B Rotation [nput Setting
¥ Trigger Condition Setting
Unit/Cal Setting
indow Function Setting
P Time—axis Preprocessing Setting
¥ Averaging Setting
¥ Schedule Setting
¥ Sig Output Setting
F Analysiz Setting

¥ Data Digp Setting

¥ Mode

B View

¥ Sifindow

¥ Option

¥ Help

) stores all expanded items. Double-click the shown item to hide it.

To hide all showing items, click the button. If too many items are shown and cannot be displayed in a

screen, hide all items and then show only required items.

¥ Meas Contral

b Edit

b Input/Output Setting

¥ fnalysis Setting

¥ Data Dizp Setting

¥ Mode

b Wiew

¥ Window

¥ Option

¥ Help
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5. Summary of [Configuration] window basic operation

@ You can see many kinds of buttons (ON/OFF button, selection button, key-in button, and Exec button
etc.) and current conditions you have set when you open all the underlying items in the [Configuration]

window.

nfiguration figuration
¥ File ¥ File F File
¥ MWeas Contral ¥ Meas Contral ¥ Meas Control
¥ Edit ¥ Edit F Edit
= 5 Input/Cutput Setting 7 Input/Output Setting
System Setting Open System Setting Open System Setting Open
Cross Gombination Setting Cross Gombination Setting Cross Gombination Setting
F Freq Ranee Setting 20kHz P Freq Range Setting 2k Hz F Freq Range Setting 20kHz
F Tnput Setting F Input Setting F Input Setting [ Open |
¥ Sampling Condition Setting Internal b Sampling Condition Setting Internal b Sampling Condition Setting Internal
¥ Rotation Input Setting b Rotation Input Setting ¥ Fotation Input Setting
P Trigeer Condition Setting Repeat ¥ Trigeer Condition Setting FRepeat ¥ Trigger Condition Setting Repeat
Unit/Cal Setting Unit/Cal Setting Unit/Gal Setting
Windaw Function Setting Windaw Function Setting ‘Window Function Setting
F Time-axis Preprocessing Setting F Time-axis PreEmcesgmg Setting m ¥ Time-axis Preprocessing Setting
P Averaging Setting Power Sum ) | Pawer Sum v 7 Pveraging Setting Power Sum
b Schedule Setting Open Averaging Parbway Value Averaging Partway Value [T
F Sig Output Setting Averaging Gondition Count Aueragine Condition Count,
¥ fAnalysis Setting Averaging Gount 10 hU
¥ Data Disp Setting Bveraging Time 10 TS T ™o
¥ Mode Exponential Averaging Weight Exponential Averaging hieight
¥ View Undo Averaging Undo Averaging
¥ Yifindow Start Time Chverlap 0% [==) Start Time Overlap 0% (=]
¥ Option Sweep Synchronized with Sig Ou |[==) Sweep Synchronized with Sig Ou | (=]
¥ Help Sweep GH Swesp GH
b Schedule Setting Open ¥ Schedule Setting
¥ Sig Output Setting ¥ Sig Output Setting
F Analyzis Setting b fnalysis Setting
¥ Data Disp Setting ¥ Data Disp Setting
¥ Mode ¥ Made
¥ View ¥ View
¥ Window b Window
¥ Option ¥ Option
¥ Help F Help

The left above shows the condition that [Averaging Setting] > [Power Sum] is set.
The middle one shows the details of [Averaging Setting].
The right one shows the condition of [Averaging count] that is set to “10” with [Numeric Input] dialog box (key

in button).

-11-
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@ Right-click on a data graph opens a pop-up menu. Click an item in the pop-up menu to open the
details of the setting in the Configuration window. .

¥ File

¥ Meas Control

¥ Edit

¥ Input/Qutput Setting

¥ Analysis Setting

“ Data Digp Setting

F Graph Format Setting
¥ Data Setting

GH1: Power Spectrum

LA g g0y -

T

Orbit Diagram
F Trace Line Setup
¥ Schedule Diagram Setting
Mode Circles Display
¥ Maode

] | Default . I_
Enlargement Exec
Reduction
Upper-limit
Lowner=limit
Register Az Manual :]
Auto Scale Lock
Lin/Log Log
MaedE/ MaeLog MaedB
Spectrum Unit 1 rms
Spectrum Unit 2 W
Spectrum Density OFF
Pha_se Urwrap

B Cursor Sstting Paak
F Graph Setting
F List Digplay
F 3D Display

Myguist Diagram

¥ View

¥ Window

¥ Option

¥ Help

& Onosokki D5-3000(DS-0320) - [Window 11 )
£ Fim(E)  Massssment ControliD)  EM(E)  put/Duod Settrg @ Anabm(d)  Oats Disp Sattmg(D) Modell)  Vw(y)  Wndow()  Optiorss() &
CHE

x =
AVG | START

jaia) Lee

|| [ Hewtim Zoom | Lin

Graph Forman Settirg ()
Data Solteg{E)

gt GH Buk Setting{H)
Dats Typs Buk Setting(E)
Frgat CH cremantal Bub. Setteg @

|| (i) o0n6

Operational procedure of [Configuration] is basically same manner in the DS-3000 series. Through understandings
of [Configuration] helps the use of the DS-3000 series. For details of each setting item, see another operation

manual.
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